SeaClear Ubungsprogramm
in Deutscher Sprache © Wyklicky Udo 2009

Herzlich Willkommen zum
Ubungsprogramm von Sea Clear 2,
einem der besten Navigationsprogramme
far Sportschiffe.

Die neueste Version dieses
Kartenplotter-Programms wurde
gewissenhaft getestet und hat den Autor
bereits weit Glber 30.000 Seemeilen
gebracht — ohne Probleme.

Hervorzuhebende Punkte an diesem

kostenlosen Programm sind:

e der gezielte Zuschnitt fir Sportboote

e Darstellung der wichtigsten NMEA g @
Daten auf einem PC / Notebook e
(GPS Pos. , Wind, Tiefe, AIS...)

e einfache Kalibrierung eigener Digitalkarten

o leichte Mendifiuihrung beim Erstellen von Wegepunkten und Routen

e Weitergabe dieser Daten an Radar, GPS oder Autopilot ect.

Sinn und Zweck dieses Ubungsprogramms ist, die ersten Schritte aufzuzeigen, mit denen wir:
Das Programm auf unserem PC installieren

Digitalkarten herstellen und in die Software einbinden

Das GPS am PC anschliel3en

Uns mit der Benutzeroberflache vertraut machen und diese individuell einstellen

Die ersten Routen planen

Spezialanwendungen starten

uusduuld

Diese Anleitung ist fir die Nicht-Computer-Segler, die aber Spal an ihrem Multitalent Laptop-
auf-dem-Schiff haben. Ich hoffe die versierteren Computerspezialisten verzeihen, dass ich
mich vor allem an die Segler wende, die kaum den Startknopf am PC finden und daher jeden
Schritt aufzeichne. Dartiber hinaus gibt es ein paar Tipps, wie einfach die Installation von
GPS und Computer ist, die ersten Schritte im Programm und das Erstellen von Wegepunkten
und Routen.

Ein standiges Multitasking bzw. ,hin-und-her-klicken kdnnen sie vermeiden, indem sie diese
Anweisung einfach ausdrucken und mit der Papiervorlage die folgenden Schritte
nachvollziehen.

Neben dem SeaClear Programm und dem Kalibrationsprogramm ist auch die
Betriebsanleitung ins Deutsche Ubersetzt. Sie beantwortet nach Durcharbeiten dieser
~how2do“-Anleitung bestimmt noch offene Fragen und zeigt die weiteren Mdglichkeiten des
Programms auf.

In dieser Anleitung sind direkte PC Befehle und Dateien zur Unterscheidung pink dargestelit.
Tipps und Beachtungshinweise sind blau, Links sind blau unterstrichen. Betriebsteile die nur
auf der CD in Deutsch (keine Downloadoption) sind, wurden dargestellt.
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Installation

Uber das Internet konnten wir uns diese Freeware (wie der Name sagt — kostenlos) standig
als neueste Version herabladen. Wir finden sie unter www.seaclear.net/.
Auf der SEA NavCD ist die aktuelle Version, komplett Voreingestellt und in Deutsch. Mit
einem Rechtsklick auf das ,, “ — Symbol wahlen sie ihren Explorer und dort ihr CD-
Laufwerk. Suchen sie im Unterverzeichnis ..\Plotter PC\SeaClear die Datei sc_setup. Mit
einem Linksdoppelklick wird die komplette Software installiert. Bestatigen sie dazu lediglich
die Installationsschritte mit OK und Unzip.
Die Software greift nicht in Windowsprogrammiteile ein und kann auch direkt von einem
Speichermedium (MMCard, USB-Stick... gestartet werden. BEACHTE: evtl. vergibt ein
anderer Rechner hier einen anderen Laufwerkbuchstaben. Nur mit dem korrekten Pfad kann
SeaClear die gewlnschten Karten, Routen und Tracks laden. Die Software bendtigt ohne den
Kartenteil 3 MB. In der SEA NavCD-Version wird das Unterverzeichnis Hilfe automatisch in
das Verzeichnis von SeaClear verschoben. Es enthalt die b otinen i
Betriebsanleitung, Ubungsanweisung sowie -karten in Deutsch. S [}S
Die Softwareteile sind bereits auf Deutsch voreingestellt — auch Suchen...
das MapCal_2. Diese Version gibt es leider im Internet nicht — offf Sean mik AYG Anti-Spyware
sondern nur auf der SEA NavCD. Uber den Arbeitsplatz (z.B. oAl G Rres
Windows-Schalter links unten rechts klicken und Explorer Higepechaften
wahlen) Programme > SeaClear kénnen sie mit einem OFFTen 2 H”: Benutzer
Rechtsklick auf die Datei SeaClear_2.exe und - N Ealoter= Al Bentaer
E ¥ MapCal_DE.exe, Uber die Funktion Senden an > By
Farelsd Desktop ein Ausfiihrungs-Icon auf dem Bildschirm erstellen.

IE Nach dem Installieren werden die Neugierigen unter ihnen, die nun bereits mit einem
Doppelklick die Software seaclear_2.exe aktivieren haben, etwas enttauscht sein. Bis auf
einen Seitenrahmen mit Minimaldaten und Weltkarte, gibt es noch nichts zu sehen — mit den
folgenden Schritten aber sind wir schnell am Ziel - unser Boot ,live* mit allen Daten auf dem
digitalen Wasser zu sehen.

Herstellen eigener Digitalkarten

In 2 Optionen wird aufgezeigt wie man SeaClear, das ja keine eigenen Karten (bis auf
Uberflieger) zur Verfiigung stellt, mit Karten nutzen kann. Option 1 nutzt vektorisierte Karten
anderer Kartenplotter, Rasterkarten oder Satellitenbilder (z.B. von Google Earth). Eigentlich
ist Papierkarten einzuscannen nicht mehr nétig — da wir ca. 20.000 Amtl. Digital-Seekarten
kostenlos erhalten kénnen — wie steht in der Anleitung. Option 2 behandelt wie man eigene
Papierseekarten digitalisiert.

Option 1 - .:____dﬁiqﬁflﬁ.gtim-v---.s
b RT FENEDA
Das Umwandeln von %
bereits vorhandenen
Digitalen Bildern aus i
anderen Nav
Programmen die z.B.
Vectorkarten oder
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N . ol * ) 7 RT VERLIDICA,
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unter ..\Plotter
PC\SeaClear\Hilfe.
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Option 2

Jeder verantwortliche Skipper hat einen ausreichenden Satz an aktuellen (Papier-) Seekarten
auf dem Schiff — warum diesen nicht auch digital nutzen. Ihr Eigentum dirfen Sie, rechtlich
problemlos, fur Ihren Gebrauch digitalisieren und somit auf den elektrischen Medien
darstellen bzw. nutzen.
Das ,Einlesen” der Teilkarten wird hier mit einem handelsiblichen A4 Scanner durchgefihrt
um Teile oder eine ganze A0 Karte einzuscannen und zusammenzufigen.
Haben sie die Mdglichkeit bei einem Copy-Shop die ganze Karte eingescannt zu bekommen
— umso besser.
Vorgabedaten fiir den Scanner sollten sein:

0 75-150 dpi

0 maximal 265 Farben

0 gespeichert und komprimiert als *.png (selbst dann hat eine A0 noch bis zu 10 MB)

Die im Ubungsprogramm herabladbaren Karten diirfen sie nur zu Ubungszwecken
verwenden. Diese sollen ihnen aber zeigen, wie einfach es ist, damit zu arbeiten - falls Sie im
Moment nicht Karte oder Scanner zur Hand haben. Speichern sie nicht mit der Endung *.jpg
— hier werden bei Plakativen Darstellungen (Tiefenangaben z.B.) die Ubergange unscharf.

Da sie zu jedem Scanner auch die nétige Software erhalten haben, kénnen sie diesen Scann-
Ausschnitt mit ihrer oder der Freeware Irfanview (http://www.irfanview.com) 6ffnen (auf der
CD unter ..\Tools\irfanview*exe). Irfan View ist ein Graphik/Foto Programm mit dem in
erstaunlicher Geschwindigkeit auch grof3e Bildformate verandert werden kénnen.

Bevor wir aber die Karte scannen, miissen wir sie in A4 Formate mit Uberdeckung einteilen.
Mehr als 8 x A4 Scanns sollten sie nicht ,zusammenkleben* — sonst wird das Bild zu grof3
(und &ltere Rechner stol3en an ihre Grenzen).

Drehen Sie nun lhre Karte auf den Ricken und messen als erstes bis zum Kartenrand, ab
dem Sie einscannen wollen. Ab dann teilen Sie die Karte in 20cm breite und 28cm hohe
Felder ein.

Rechts beginnend mit Feld 1 bis 4 scannen Sie nun
die ersten 4 Kartenteile ein. Damit durch Lichteinfall
die Kanten des Scanns nicht allzu unscharf oder
unsauber werden, konnen Sie den Scannerdeckel mit
einem Buch beschweren oder mit einem 1 3 2
lichtundurchlassigen dunklen Tuch abdecken. Sind
die Rander zum Scanner-Deckel sehr hoch miissen
Sie evtl. falzen.

Nach den ersten 4 Scanns drehen Sie das
Kartenblatt um 180° und beginnen mit Scan Nr.
5u.s.w.

Unsere Karte ist zwar nun eingescannt, muss aber noch nachbearbeitet werden. Wir machen
dies in 5 einfachen Schritten:
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o Irfanview-Software aktivieren

e Datei einladen Datei > Offnen (Arbeiten sie bei der ersten Ubung bitte mit den
mitgelieferten Karten und noch nicht mit ihren Eigenen). Suchen sie den Pfad in den
sie die 3 Ubungskarten kopiert haben, sie sollten in ..\seaclear\Hilfe zu finden sein)

e Drehen Da die Datei horizontal liegt kdnnen wir sie mit Bild > Rechts drehen optisch
senkrecht stellen

e Scharfen Damit Details besser hervorgehoben werden wird das Bild nachgeschérft.
Bild > Effekte > Einstellungen/Vorschau > Sharpen > Value: vom voreingestellten
Wert 20 auf 30 andern.

e Farben anpassen Mit dem Werkzeug Bild > Farben andern kann der Helligkeitswert
und das Gamma nachgestellt werden (hier muss fir jede Karte etwas experimentiert
werden).

e Speichern Das umgewandelte Bild sollte als neue Datei gespeichert werden, da
sonst Korrekturen nicht mehr mdéglich sind. (z.B. Speichern unter mapla.png)

In gleicher Weise verfahren wir mit der Ubungskarte map2.png ! Gespeichert unter
map2a.png?

Mit dem Windows Paint Programm kénnen nun die Karten zusammengefligt werden.
Man klickt mapla.png rechts an Offnen mit... > und wahlt Paint. Paint ist das
Zeichenprogramm jedes Windows Betriebssystems. Start > Alle Programme > Zubehor >
Paint.

Beachte: Bei Windows95 muss

vorher das Bild als *.bmp ]
umgewandelt werden.

Nachdem das Bild geladen ist wird

die Datei nun vergréR3ert. Bild > {Reribure

Attribute. Im daraufhin gedffneten = ——

Fenster werden die Pixelwerte der s LI e
Breite von 1401 auf 3000 erhoht. Die | . & Soungie o 51 481 Purkte pioZal
Pixelwerte der Hohe von 1901 L0000 0 e 2o )
korrigieren wir nur minimal auf 2000. ¢ . '

Sollten aber Bilder darunter gesetzt 0 & Ol Oem  @PFiel__

werden, kann auch hier der Wert - - o

deutlich erhoht werden. [ Ca)' o Sl

Wir 6ffnen ein Zweites Mal tber den

Arbeitsplatz die Datei map2.png mit [

Rechtsklick Offnen mit... > Paint. Uber Bearbeiten > Alles markieren > Rechtsklick im Bild
Kopieren haben wir es temporar gespeichert und schalten in der Fulleiste auf Paint mit

i mapl.png (bmp). Hier klicken wir in =
das Werkzeug der Palette ganz links
oben (den gestichelten Rahmen).
Nun verschieben wir den Rollbalken
bis wir nur noch einen kleinen
Ausschnitt des mapl.png am linken Rand erkennen
kénnen. Mit einem Rechtsklick im noch leeren
weilRen Feld > Einfligen taucht unser map2a.png auf.
Mit links gedrtickter Maustaste wir das Bild nun exakt e - o
auf die Nahtstellen verschoben. Dabei ist es auch i ‘ =
mdoglich am Rollbalken weiter nach links/rechts oder unten/oben zu rollen. Falls sie aber in
das alte Bild klicken ist das neue Bild ,fest". Bei Bedarf kann aber dieser Befehl mit
Bearbeiten > Ruckgéangig annulliert werden.

Wenn sie nun an den optisch sichtbaren Kartenrand rechts unten rollen und den Mauszeiger
genau auf die Ecke setzten, zeigt Paint die Koordinaten rechts unten an. Wir wahlen erneut
Bild > Attribute und geben diese Koordinaten ein (z. B. Breit 2709 und 1944 Hoch) OK.
Sofort ist unser Bild nur noch so grof3 wie wir es bendétigen. Nun dirfen wir die Grolze aber
nicht mehr &ndern. Im nachsten Abschnitt wird das Bild kalibriert und hier weist das
Programm jedem Bildpunkt (Pixel) eine Koordinate zu. Wenn wir also etwas wegschneiden
oder verkleinern wirden, kdnnten sich diese Adressen nicht mehr decken. Nachbearbeiten
dagegen kdnnen wir immer wieder. Wie z. B. ein neues Leuchtfeuer einzeichnen oder ganze
Info Hafenkarten in nicht bendtigte Ecken platzieren (Diese sind aber nicht kalibriert!).
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Wichtig beim Speichern ist die Endung, also .png eintragen oder wahlen. MapCal von
SeaClear kann fast alle Bildformate erkennen und wird sie komprimieren (falls sie das WCl
Verfahren nutzen — siehe weiter unten)

Die Dateinamen sollten einen Bezug zu lhren Karten, oder dem Seegebiet haben. (also z.B.
Adria_NE oder DE_4812) So sind sie spater leichter zu finden sind — falls sie Anderungen
daran vornehmen wollen.

Speichern sie die Karte als Carriac.png unter .\SeaClear\charts !

Ein Beispiel hierzu: Nach- Hachher

Kolorierung und Entfernen von i —

Daten, die fir elektronische SN\ gaasBo T e -

Seekarten nicht mehr notwendig e T

sind, wie Hilfslinien, Windrosen Sy

USW.. Ty‘r.r;'_'_f B_a)__ _L i T,
[& /‘"“Q;_,_,/ Hater o

Im Windows Paintprogram heh o /, 7 S

kénnen diese Pixelbilder véllig £ x. o )

umgemalt werden.

Hier ein Beispiel wie sie einfache Seekarten mit Bildausschnitten z.B. von Google Earth
http://earth.google.com/ nachbereiten kdnnen.
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Dies ist nattrlich eine ganz schéne Arbeit, macht aber Spaf3 und sie werden mit dem
kinftigen Seegebiet sehr vertraut. Weiter zur Kalibration!
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Kalibrierung der Karte

Nun konvertieren und kalibrieren (was ist das? = veradndern und Koordinatenzuweisung)
wir unsere Seekarte carriac.png.

Das heif3t, wir weisen der Karte fiir jeden Bildpunkt (= Pixel) Koordinaten im Format
G°M.Dezimal’ zu. Die Software kann eingehende GPS Daten nun auf dem Bildschirm
aktualisieren und unser Schiff wird dort dargestellt, wo wir uns befinden. Das Konvertieren (es
ist nicht zwingend notig!) erleichtert aber vor allem &lteren PC die Berechnung des
Schiffortes, da nur der Bildschirmausschnitt und nicht die ganze Karte berechnet wird. Beim
Konvertieren wird ein neues verdichtetes WCI-Datei-Format geschaffen. SeaClear schreibt
und liest die Koordinationsdaten direkt aus dieser Karte anstatt von einer externen Datei und
[&dt nur den sichtbaren Bildschirmkartenteil, womit viel Arbeitsspeicher gespart wird. Im
Gegensatz zu anderen Programmen wird nur eine Datei flir eine Karte gebraucht — da in
diesem Format Bildinformationen, Infos und Kalibrierung stecken.

liAls erstes 6ffnen wir dazu das MapCal-Werkzeug. ..\SeaClear\

Die Deutsche Version wurde automatisch geladen. Im Original-Download gibt es diese
Version nicht — erklart werden beide Versionen.

Die dargestellten Befehle beziehen sich auf die Deutsche Version von MapCal_DE
Falls sie mit dem Original arbeiten, doppelklicken sie im Verzeichnis:
.\SeaClear2\mapcal_2.exe .

Wir haben uns entschlossen das WCI
Format zu nutzen. (Ansonst
Uberspringen sie diesen Teil, haben
aber zur *.png Datei eine Chartcal.dir
Datei, die von allen Karten im Pixel- ettt

4%/ SeaClear Calibration Utility

Datei  Karte | Bearb. <
Aindern Geladens Karte als Wil
Importiers Kalibrationen  » Geladene WCI als BMP

Karterr:

. X Kartenverwalbung b Eing Datei als Wl
Format genutzt wird. Sollte eine Karte Warkung b Bilder im Yerzeichnis als™WCT
geléscht werden sind die Daten daftr - ¥ Sperelatd ool verssichis | MAR im Verzeichnis als WCI
immer noch in dieser Chartcal.dir Datei) ! 1= Innn fnir '
Mit Tools > Convert > Singel File to WCI offnet

sich ein Fenster, in dem unsere PNG aufgefiihrt sind (sonst missen sie den Verzeichnispfad
prufen =..SeaClear\charts).

Wir wéhlen carriac.png mit einem Doppelklick und ein weiteres Fenster 6ffnet sich. Es ist das
Zielfenster (und kann das gleiche Verzeichnis sein). Dort liegen bereits Kartendateien *.wci.
Wir bestéatigen das konvertieren nach *wci mit Speichern.

Nun dauert es einen Augenblick, bis die alte Datei in eine neue umgewandelt wurde.
Nachster Schritt ist die Kalibration der Karte. Wir vergeben also Koordinaten in die Karte.
Uber >File >Open Image gelangen wir in ein Fenster, indem das ganze
SeaClear2 Verzeichnis aufgefihrt ist. Doppelklicken sie hier auf Charts. Nun sollten mehrere
Karten auftauchen.

Tipp: Wenn ihre Karte eine andere Endung hat, z.B. *gif, &ndern sie im Rollmeni von
Dateityp Chart File in Any File — nun wird sie angezeigt.

Eine davon kennen wir schon und brauchen die png-Dateien nicht mehr.

Die einzelne Datei mit der rechten Maustaste anklicken > [6schen. Dadurch sparen wir
Speicherplatz und verhindern einen Konflikt beim nachfolgenden Update.

Warum? MapCal wird nach dem Kalibrieren unserer Karte das gesamte Verzeichnis
durchsuchen und uns melden — da ist 1 Karten die nicht kalibriert ist — Was sollen die dort?
Sie laden aber nun carriac.wci mit einem Doppelklick. Es 6ffnet sich ein Info-Fenster fur
unsere Karte.

Diese Karten-Informationen (die Sie lhrer Originalpapierkarte enthnehmen) sollen uns spater
helfen, im Programm SeaClear 2 Informationen abzurufen.
Erneut vergeben wir also einen Kartennamen (das kann, muss aber nicht der Dateiname

sein). Er dient nur zur Information die wir spater direkt aus SeaClear lesen kénnen (Datei >
Karteninfo). Fur diese Ubung wéhlen wir Carriacou, Grenadines.
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Karten Information Yergehen sie higr ginen neusn
+ Hartennamen - et muss nicht mit

,-""f dem Dateinamen dbereinstimmen

k.artenname: |Earia-:|:|u, Grenadines #4|U5_334-5
Bilddate; ] CProgrammetSeaClear_MChantz\cariac woi
kd afhstab: 1/ Frojektion; K.arten-0 atunm;

25000 — | Mercatar %s a4 E
Warrangstube: |
at Vergatz: |000°00.000 N

L3 Andern sie die Angaben, die

. — zie ihrer Orignialkarte ertnehmen.

MR ] Longitude O | “ersatz 000°00.000 E
b eter - Eine GPS Morrekiur wird hier

eingetragen

4&‘

\

Wieiter Infa:

gescannt 2007 Skipper UDO
Driginal 1932 Korrektur 2004 ™ 7\;satzinfos kéinnen sie hier eintragen

Scale
Wir andern die Scale indem wir die Vorgabezahl [6schen und 1/25 000 eingeben (1cm auf
der Karte entspricht also 25000cm in Wirklichkeit).

Priority
wir kénnen Prioritdten vergeben (ler Karten werden bei selbem MalR3stab vorrangig geladen!)
und wissen auch wie aktuell diese Karte ist.

Depth Unit

Bei Depth Unit wahlen wir, indem wir auf den Pfeil klicken, Meter. Einige
Karten sind ja noch immer mit Fathom oder Feet versehen. Dies dient nur zur Information —
Ihr GPS und auch SeaClear wissen nicht wie tief es wirklich ist, aul3er sie haben den NMEA —
Datenbus gekoppelt — dann haben sie die Tiefen-Daten in einem eigenen Feld in der
Navigationsleiste (siehe GPS Anschluss)

Projection
Fur die Definition der Karten-Projektionsart aktivieren wir das Auswahlmenu (in den Pfeil
klicken) und wahlen fur unser Beispiel Mercator

Kartendatum )
und schlie3en mit der Uberprifung des Kartendatums (meist ist es WGS 84) ab.

Other Information

Unter Other Information kénnten wir, wann und wer diese Karte eingescannt und kalibriert hat
schreiben.

Es mag also so aussehen:

Scanned by mein Name 05/200?

Kartenaktualisierung 09/1999

Das bestatigen wir mit dem OK Schalter.
In der Kopfzeile wird nun auch schon der von uns vergebene Kartenname angezeigt.
Nun wird kalibriert - indem wir irgendwo, (oder exakt) in der Nahe des Grauen Vorgabe
Kreuzes auf der Karte links oben, rechts die Maus klicken. Es erscheint ein Untermenii und
hier wahlen wir Add New Cal. Point.

Lat/Lon Eintragungen sind im Format: G°M’.Dezimal N/S oder E/W zu machen.
Zeigen sie in das entstandene Quadrat mit Kreuz, links klicken und halten und verschieben
sie es bis es sich mit dem grauen Karten Kreuz deckt. Dies ist auch mit den Pfeilen links
maglich.
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Auf der Ubungskarte ist dieses Kreuz vorgegeben da sie ja die Originalkarte nicht haben und
am Kartenrand die

File Edit Toaols << ez Lat/Lon Daten

Cal I Eu:nru:lerl - G1535 W schwer ablesen
konnen.

Calibration Point - -

IF'oint 1 ;I hier milzen die richtinen Kalibrierungsdaten Tragen sie in die

W Lock Lat & Long angegEben WE-'-rdE-'I‘I Lat/Lon Felder nun

Lat [012°50.0000 N / die auf der Karte
| angegebenen
Long |051 35,0000 v

Koordinaten ein.

¥ IT - ACHTUNG: _
1 r 129360 M Vergessen sie
~ |129 >~ N | nicht das

\ Vorzeichen E (Ost)
Mit cen Pieilen kann das
aktuelle Kalibrisrungskreuz auf W (WeSt)
IN.:. Grid -, _in Pixelschritten verschoben werden um_Z_USte"e_n-
Bei ihren eigenen
Activate Changes t. in diezem Feld wahlen wir nach dem Scans (gescannten
2ten Kalibri kt "M | Gric"
en Kalibrierungspun ormal G Karten) brauchen
| Llona: 0 sie sich nur einen

Punkt weit links oben suchen. Dies muss nicht unbedingt ein Gitterpunkt sein, auch eine
Tiefenangabe oder eine Landmarke, die sie mit dem Zirkel herauslesen ist ausreichend.
Haben sie nicht allzu viele Kartenteile zusammengeklebt reicht es nun, recht rechts weit
unten einen 2ten Punkt zu bestimmen. Da beim scannen aber immer minimale
Verschiebungen méglich sind, kdnnen sie endlos viele Kalibrierungspunkte vergeben.
Unsere Ubungskarte hat keinen solchen Knick!
Nun rollen wir mit den Rollbalken die Karte zur rechten unteren Ecke.
Erneut klicken wir rechts, wahlen Add New Cal. Point und tragen die Daten im nun
veranderten Fenster Point 2 ein.
Im Rollmenu Grid wahlen wir > Normal Grid und Activate Changes,
pinkfarben wird Uber unsere Karte ein Gitter (=Grid) gelegt. Bei Bedarf
kénnen also weiter Punkte vergeben werden — bis das Gitter sauber aufliegt.
Da sich Fehler multiplizieren (und wer kennt das als Segler nicht) vergeben wir einfach noch
ein paar Gitterpunkte und rollen die Karte noch etwas héher. Ab sofort werden die Werte
vorgegeben und missen nur noch minimal veréandert werden.
Wie gehabt klicken wir rechts Add New Cal. Point, bezeichnen die Punkte neu indem wir die
entsprechenden Koordinaten eingeben und wahlen erneut Activate Changes
. Sobald wir mit dem Gitter tber der Originalkarte zufrieden sind, speichern wir
dies mit File > Save Calibration
Um das ganze jetzt in unsere Kartenliste (ohne diese findet SeaClear die Karte nicht)
einzutragen wahlen wir Tools > Autoload List > Scan for New Charts.
Das Resultat bestatigen wir und fihren erneut

Tools > Autoload List > Recreate (die evtl.
Meldung ersetze scan kdnnen sie ignorieren) durch.
Schnelle Rechner fiihren nun, fir das Auge kaum erkennbar, Datei  Kate Bearb.

einen Scan und Search durch und melden uns das Ergebnis — wir

haben 5 (oder schon mehr?) WCI Karten im Verzeichnis und EinclEle .
bestatigen dies. Uberpriifen kénnen wir dies mit File > Open Offne aus der Liste %
From List und schon wird auch Schliefie Karte |
unsere neue Karte mit angezeigt. - I

Das war's — wir kénnen MapCal schlief3en. Ein noch getffnetes SeaClear muss auch
geschlossen werden

Beim nachsten Start von SeaClear wirde ab sofort die beste Karte fir die GPS Position
automatisch geladen.

Ein kleiner Tipp fur Segler, die Schwierigkeiten bei oben angefuhrten Prozeduren haben oder
noch keine eigenen Papierkarten fir das jeweilige Revier besitzen. . Wie man aus einem
kostenlosen Pool aus tber 20.000 amtl. Seekarten Rasterkarten fir SeaClear erstellt, ist im
.\SeaClear\Hilfe\Digitale Kartenerstellung.pdf erklart.
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Fremdkart

en (z.B. bmp,kap/bsb...)

Der Seekartenplotter SeaClear erkennt fast alle Bildformate. Ist das Bild/Karte aber nicht
kalibriert 6ffnet sich automatisch ein Kalibrierungsfenster. Die Daten sind dann einzutragen
(siehe Anleitung weiter oben).

Karten die bereits vorbereitet sind (WCI oder kap/bsb) miissen nur in das Verzeichnis

.\SeaClear\c
Wird dabei ei

harts kopiert werden.
n Unterverzeichnis angelegt muss mit der MapCal_DE dieser Pfad

aufgenommen werden (siehe Bild unten).

Bearbeiten -

Erstelle Verzeichniss - << klicken und nach den Unterordnern suchen.

In MapCal_DE (Verwaltungsinstrument fiir SeaClear) muss jede Anderung der
Karten mit einem Update (iber

Bearbeiten >

Kartenverwaltung > update

bestatigt werden!
SeaClear kann KEINE Vectorkarten lesen - er kann also nicht direkt die Seekarten von
z.B. NaviChart einlesen!

f'fgéaﬁ’[éarﬂtaﬁihraﬁun"ﬂﬁfi‘t"ﬁ

=l

Datei  Karte Beab. <<

kal F.aite

k. alibrationzp

—

tiere Kalibrationen

Spere La
Lat |000°00.0

Kartenigerwaltung
i arkun

Long | 000°00.0000E |

Yoo
%0

WProgrammetSeaClearts CHARTS

&' farten C
T C:\ProgrammeSealleartsCHAR TS Nordsed
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Das GPS am PC anschliel3en

Dies ist der grof3te Stolperstein flr viele Nautiker und Segler. Am einfachsten funktioniert es
mit einer GPS Maus mit einem Kabel zum Com1 Port — hier wird aber der griine Anschluss
der Externen Maus fir die Stromversorgung genutzt. Es muss weder an der Software noch
am PC/Laptop etwas umgestellt oder Treiber installiert werden.

Leider haben moderne PCs/Laptops oder Netbooks keinen Com1 Eingang mehr. Siehe RS
323 Anschluss unten im Bild. Achten sie also darauf eine GPS Maus einzusetzen die einen
USB Anschluss hat. Die nétigen Treiber um eine virtuelle Schnittstelle herzustellen werden
mitgeliefert oder kdnnen im Internet herab geladen werden.

Beachte: Bei Vista gibt es Treiber fur 32 oder 64 Bit Versionen. Win 7 aktualisiert (online
vorausgesetzt) die Treiber automatisch. Ohne Treiber funktioniert das GPS nicht! Nach der
Installation notieren sie den virtuellen ComPort und die Baudzahl.

Beachte: Nutzen sie immer denselben USB Port sonst vergibt die PC Steuerung evtl. einen
weiteren ComPort — man musste die Software dann jeweils auf den richtigen ComPort ein-
/umstellen. In jeder Software ist dieser ComPort und die Baudrate einzustellen. Bei Bluetooth
GPS ubernimmt die Bluetooth Software die Treiberinstallation. Bluetoothgerate funktionieren
aber nur bis zu 6 Stunden. Wenn mdglich sollten die GPS-Geréate an eine 12V
Dauerstromsteckdose (oder ihr Torn ist nicht all zu lange).

Nutzen sie dazu auch die Betriebsanleitung ihres GPS.!

Zur Einspeisung des GPS Signales von Bord-GPS brauchen wir?

e Ein NMEA (= Standart Datenprotokoll fir die Seeschifffahrt ) kompatibles GPS (einige
kleine Hand-GPS sind dies nicht) oder vorzugsweise eine GPS-Maus

e Ein Mehrlitzen-Kabel vom GPS bis zu ihrem PC/Laptop an Bord (dies und unten
aufgefiihrtes entfallt bei GPS Mausen)
Einen 9 Pin Mama (also Locher, keine Stifte) Stecker fur den Com1-Eingang
Evtl. ein Adapterkabel Com1 > USB

e Etwas Zinn, Elektrowerkzeug und einen kleinen L6tkolben

Ihrer GPS-Betriebsanleitung entnehmen sie die Litzenfarbe fur die 2 bendtigten Kabel:
Masse, und Tx (Daten transmite = senden).

Beachte: einige GPS Geréte haben fur den Datenaustausch eine eigene Masseleitung (Data-
Ground).

Sind mehr NMEA -kompatible Geréte im Schiff eingebaut (der sogenannte NMEA-Daten-Bus)
muss ein Multiplexer eingesetzt werden (s. weiter unten), damit der PC Wind-, Tiefen-,
Autopilot-, ...- Daten verarbeiten kann.

GPS PC-RS232 (DB9)

DATA OUT = Puil 2 (RxD)

— | GROUND PIN S (GND)
DATAIN--[4— — — —@-PIN3 (‘!’xd}

DE® Male

USB —> Serial RS232

Signal Information

2 Data reception Ry Connection to GPS

3 Data transmission Caonnection to automatic
Tx pilot

5 Ground Gnd

Achtung: die Tx (PIN 3) — Daten dirfen nicht direkt vom GPS an den Autopilot geleitet
werden. Daten die SeaClear nicht weiterverarbeitet, werden ungeprift durch seine Software
durchgeschickt, einige Daten aber werden umgesetzt und der ,Leser” (z.B. der Autopilot)
braucht diese gewandelten Daten.
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Nun muss Masse auf Pin 5, Rx auf 2 und Tx auf 3 gel6tet werden (falls Daten weitergeleitet
werden sollen). Dazu sind die kleinen Stecker vorne beschriftet. AbschlieRend verbinden sie
den Stecker mit dem Com1 Port ihres PC. Ist dieser belegt durch ein Wetterfax oder andere
Gerate, nutzen sie den Com2 Port. Moderne Laptops haben solche 2 Com1 Ports aber oft
nicht —was nun? Die Computer Industrie bietet dazu Verteilerdosen an oder sie stecken
einfach bei Bedarf immer um. Die neuen Laptops haben selbst diese Com Schnittstelle nicht
mehr — es gibt aber Adapter fir den USB — Eingang oder sie nutzen gleich eine GPS Mouse.
Arbeiten sie mit Com2-256 muss dies der Software mitgeteilt werden. (siehe Bearbeiten >
Einstellungen > Com in SeaClear ). Fir eine Prifung des GPS Signals (kommt Uberhaupt
etwas und an welchem Port?) kbnnen sie die Software GPS Test nutzen (sie finden sie auf
der SEA NavCD ..\Nautik — lesen sie die dortige Hilfe GPS Test how2do.pdf)
Im GPS —Setup sind folgende Einstellungen zu prifen.

- Arbeitet es mit WGS 84, NMEA 183 2.0 (bei Magellan NMEA 183 B)

- und einer Bautrate (Transportgeschwindigkeit) von 4800. (Ausnahme AIS!)

- Ist das GPS zum senden aktiviert?
Nur in ganz wenigen Einzelféallen muss in SeaClear oder dem GPS noch weiteres ein- / oder
umgestellt werden.

Tipp: GPS Mouse — diese funktioniert bei GFK-Booten meist direkt im Schiff, bei Alu- und
Holzschiffen sollte sie z.B. am Fenster der NavEcke platziert sein — muss also nicht mit
externer Antenne betrieben werden. Falls die GPS Maus Uber USB angeschlossen ist, wird
ein anderer Com Port belegt. GPS Test zeigt nach Anklicken von Scan Com Port wie dieser
Port heil3t! Fiihren sie den Test evtl. auch mit 9600 Baud durch — einige Sirf Il Mause
arbeiten mit einer hheren Baudrate.

SeaClear kann noch viele weitere Daten darstellen. Sollten sie also ein NMEA fahigen
Windmesser, Tiefenmesser oder AIS Empfanger haben missen diese an einen Multiplexer
angeschlossen werden.

GPS b
RZ232

WIND » o |«=p| PC

i

I

0

=

=
DEFTH = = HMEﬁI I;:-{EE;‘
COM-
PASS >
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Dieser Multiplexer gewdhrleistet, dass ihr PC die verwirrend vielen, gleichzeitig erhaltenen
Daten, auseinander sortiert bekommt.

Bezugsquellen fur eine Eigen-Installation sind z.B: www.svb.de

Die Verkabelung und das Anldten der Schnittstellen ist bei allen Steckern dieselbe. Neue
Laptops die keine Com1 Buchse mehr haben missen nun noch einen Wandler einsetzen.
Hier werden die NMEA Daten USB fahig umgesetzt. Praktisch funktioniert das mit einer
Kupplung in die der 9pin Stecker eingesteckt und an der USB Seite
in den Laptop gesteckt wird. Uber eine eigene Software wird im
Laptop ein virtueller ComPort erstellt und dem Stecker zugewiesen. i
Die Software simuliert einen ComPort und zeigt diesen an. In diesem 5
Fall muss dies aber auch SeaClear mitgeteilt werden. Uber *'L
Bearbeiten > Einstellungen > Com wird der neu verwendete
ComPort eingestellt. Ab sofort kdnnen Wassertiefenalarme vergeben, AIS-
aurustungspflichtige Schiffe angezeigt oder der Windwinkel am Schiffsymbol dargestellt
werden. So verfahren sie auch wenn lediglich eine GPS Maus per USB angeschlossen
werden soll.

Na, schauen wir was passiert und klicken die seaclear 2.exe an.
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Die Benutzeroberflache

Nach dem Aktivieren (durch Doppelklick) der Datei seaclear 2.exe oder dem E
erstellten Bildschirm-lcon (der Verknipfung zum Programmestart) 1adt die Software 2 2=
zusammenhangende Rahmenfenster.

Der Datenrahmen, die Navigationsleiste, erscheint rechts vom Kartenfenster (diese kann
auch nach links versetzt oder geschlossen werden). Unabhéngig was nun passiert orientieren
wir uns auf dem Bildschirm und da uns das leichter in Deutsch fallt, wurde die Deutsche
Sprache bereits eingestellt.

Sonst = Klicken sie in Tools > Properties und in dem gedffneten Fenster im Language-Abteil
auf den Schalter mit den 3 Punkten (...). Wahlen sie aus dem erneut getffneten Fenster
German_2.Ing mit einem Doppelklick. Sichern Sie diese Einstellung, mit Save.

Sieht ihr Bildschirm nun so aus?

Irgendetwas mit dem Dateneingang des GPS
stimmt nicht!

Es ist falsch, nicht angeschlossen, oder kann in
ihrer Wohnung keine Satellitendaten empfangen
(wie war‘'s mit dem Fensterbrettl). Ist er an den
Com2 Port angeschlossen oder stimmt die
Ubertragungsrate nicht? — klicken Sie in
Bearbeiten > Einstellungen > Com und &ndern
diese. Zum Planen oder Routenerstellen kann
SeaClear aber auch ohne GPS verwendet werden
(s. dort).

Datei Bearbeiten >

Log

Trip 0.00
Stunden 0.03

Wiegepunkt
I 1

Im griinen (hier grauen) Bereich sind wir, wenn das GPS Fenster Daten anzeigt. Falls sie dies
von Zuhause aus probieren ist ihr Schiff halt in Zrich, Miinchen oder Wien und wird nicht
sehr schnell live* irgendwo hinfahren.

Wenn sie nun mit der Maus (die sich auch noch standig &ndert) tber den Bildschirm fahren,
werden Infos beim Dartberfahren (Aktivieren) in der Navigationsleiste kurz erklart.

terranean Sea - 1:20000000 @ 100%] - [RR=4] _[Ofx]| Befindet sich das Kreuz im
Kartenteil, erhalten sie die

Datei Bearbeiten >> | position der Maus sofort
Kartenname / Mafistab / Zoom GP errechnet und dargestellt im
Lat / Lan Eoordinaten 48?3173 N re_chten unteren Fenster,
k.urs Liber Grund 010°47'750 E mit Richtung und _
Geschwindigkeit Liber Grund SOG 0.0° Entfernung zum GPS. Die
Miszweizung vor Ot . einzelnen Angaben sind im
Weltzeit und Dratum ;E_OG _ 01 [E:I'Ii:-t Manual auf der CD
ISEMEIEUND 1 ./SeaClear/Manual oder als
ITC 270402 15:37:26 Download (Handbuch -
Log 0.05 | auch dazu gibt es eine

Trip 0.05 deutsche Ausgabe, siehe
Stunden 0.10

Download) erklart.
‘wiegepunk Sobald NMEA-fahige
j Zusatzgerate
angeschlossen sind und ihr
Bildschirm ausreichend
FRouten groR ist, werden auch Wind-
Offne Boute , Elektrokompass- und
e L Tiefenangaben dargestellt.

Zeige Wegepunkt
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Blattern sie nun doch einmal mit Bearbeiten > Einstellungen in die Optionen. Andern sie die
Grundeinstellungen aber nur, wenn sie die Funktion auch verstanden haben. So kénnen sie
SeaClear personalisieren. Farben, Anzeigen und Aktionen kdnnen beliebig verandert werden.
Diese Einstellungen werden in einer eigenen Datei festgehalten und missen nicht standig
neu geladen werden. Sie kdnnen aber jederzeit zurlick — oder erneut umgestellt werden.
Auch ohne grol3e Planung ist es ein ,Aha“-Erlebnis sobald ihr Schiff den Hafen verlasst und
sie in Sekunden sehen, wo sie sind, wohin und wie schnell das Schiff fahrt (Normalmodus).
Es kann eine Peilung geprift werden, indem sie mit der Maus vom dargestellten Schiff in die
gewtinschte Richtung ziehen (Tatséchlich das Kap liegt in 235°) — nur erhalten sie nun sofort
darlber hinaus die Information, wie weit es noch weg ist. Der Track weicht von unserem Ziel
deutlich ab — ,Ruderganger 10° mehr anluven, hier ist Strom*“ (oder packt unsere Jacht doch
keinen Wendewinkel von 35°7?).

Ihre Navigation wird nicht leichter — aber die Berechnung!

Noch immer mussen sie ihr Schiff splren, sobald sie in den Flachwasserbereich kommen -
drauRen rundum sehen und ein Auge auf das Wetter haben — aber zwischendurch kénnen
Sie die Mitsegler mit solch einem Eindruck Giberraschen. Hier der Zweitbildschirm im Cockpit
einer Jacht die nachts von Grado nach Koper segelt. (Bearbeiten > Einstellungen > Andere
der Nachtmodus im Filter(3) auf -40, also negativ verandert)

Darstellung im Machtmodus

Windpfeil

Track

Jacht mit Fahrtrichtung
Entfernungstinge

Peilcurzar
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Routen planen

Routen sind eine Reihe von Wegepunkten, die aneinander gehangt sind.
Eine Route kann:

e neu erstellt werden

e aus vorhandenen Wegepunkten kombiniert werden

e mit einem alter Track zu einer Route umgestellt werden.
Auch kénnen mehrere Routen aneinandergehéangt werden. Fahrt unsere Jacht
vollautomatisch, missen (Option von Benutzer Einstellungen) wir, mit Erreichen eines
Wegepunktes (Alarmton) den nachsten Wegepunkt bestatigen und kénnen die Segel neu
trimmen.
Zum Planen der Route benétigen sie kein GPS — wir kdnnen also bereits Zuhause auf
demselben oder einem weiteren PC, ohne das GPS umzumontieren, vorarbeiten. Verbleibt
der PC auf dem Schiff bendtigen sie nur die SeaClear Software und ein Speichermedium
(USB Stick, Diskette...). Speichern sie die benétigten Karten (falls sie nicht als Update eh
Zuhause sind) und beginnen sie eine neue Route.
Der Automatik Modus muss dazu ausgeschalten sein!
Damit sie mit der Installation von Karten weiter vertraut werden, verschieben sie nun die
vorbereitete Ubungskarte adria_ne.wci von ..SeaClear\Hilfe nach ..SeaClear\Charts und mit
dem Softwareteil MapCal (das Kalibrierungswerkzeug!) aktualisieren (falls nétig) sie die
Karteneintrage.
Wird mit File > Open From List die Karte adria_ne.wci angezeigt?

Wird mit die Karte aufgefuhrt?

Beenden sie SeaClear und starten es erneut.

Mit einem rechts Klick im Kartenfenster von SeaClear 6ffnet sich ein Untermenl Karte > zeige
alle und wéhlen sie die adria_ne.wci an. In unserer ersten Ubung wollen wir von Izola nach
Umag segeln.

Optional kénnen sie auch mit Datei: > Offne Karte > zeige alle unsere Adria NE laden.

Mit Bearbeiten > Routen Editor erscheint ein neues Arbeitsfeld in der N
Navigationsleiste und sobald der Cursor im Kartenteil auftaucht veréndert er sich
in ein: neues Kreuz mit Pfeil. 1

Mit links Einfachklick und Halten verschieben wir die Karte bis wir 1zola gefunden haben. An
der Hafenmole von Izola beginnt unsere Route.
Damit wir diese genauer sehen kénnen, klicken wir dort rechts und wahlen Zoom > 200%.
Dies geht auch wenn sie mit einer Maus mit Drehrad arbeiten und dies eingestellt (aktiviert)
haben, indem sie das Drehrad nach vorne rollen.

XTE Max | 0.050 2 Mit einem Doppelklick erzeugen wir den Startpunkt und benennen ihn im

| Name Navigationsfeld unter Name mit Izola und klicken sofort darunter auf

2ol Update.

ibk Update Mit rechts Klick > Zoom > 100% kommen wir wieder in die Normalansicht.

~| Lische Auswahl  Unser Weg flihrt uns mit gutem Abstand nérdlich von Rtic Romek vorbei.
Dffne Route Also Doppelklicken wir hier erneut und nennen diesen Wegepunkt Romek

. SEfiC’:';““”‘e > Update. Der dritte Wegepunkt liegt nérdlich vom Cap Madona —

e i dieselben Schritte Doppelklick, Namensgebung und Update. Nun runden
wir das Cap Savudrija — hier vergeben wir gleich 2 Wegepunkte. Savudrijal liegt NNW vom
Kap und Savudrija2 Westlich. Der vorletzte Wegepunkt ist die Westliche Ansteuerungstonne
von Umag (Name = Umag-West) und dann setzen wir unser Ziel an die Zollpeer von Umag,
das wir schlicht Umag nennen.

Mit dem Schnellschalter Speichere Route 6ffnet sich ein Unterfenster und verweist bereits auf
den Ordner Route und schlagt einen Routennamen vor Izola — Umag.SRW . Sind keine
Wegepunktnamen vergeben oder gefallt ihnen der Routenname nicht, &ndern Sie ihn und
speichern diesen.

Nun wahlen wir erneut den Zoom > 50% und haben die Karte mit der Route im Uberblick.
Wie lange ist sie und welche Zeit benétigen wir dazu. Dazu klicken sie in den Schnellschalter
Routen Liste.

Uber Bearbeiten >Einstellungen > Route kénnen sie die Durchschnittsgeschwindigkeit von
der Vorgabe 5 kt auf ihr Schiff einstellen. Bei meiner Berechnung sind die 12 nm in knapp 3
Stunden zu fahren.
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In dieser Liste kbnnen wir alle Daten &ndern (soweit nétig) und mit update bestatigen oder
schliel3en diese einfach nach Ansicht wieder.

Uns gefallt der Wegepunkt Savudrija2 noch nicht — er liegt zu nahe an der :

Kiiste. G %/
Ganz einfach — Linksklick und halten, dann ziehen sie ihn etwas weiter

nach West: Mit Update der Schnellschalter wird er aktualisiert und nun muss nur noch die
Route erneut gespeichert werden Speichere Route. Andern sie nur die Position geschieht
dies ohne Fenster, &ndern sie einen Wegepunktnamen mussen sie einfach den angegebenen
Routennamen bestéatigen oder einen Neuen vergeben (update!). Mit dem Schnellschalter
SchlieRe Editor sind wir wieder in der Normalansicht.

Die Route ist noch immer sichtbar und im Routen Statistik Fenster werden nun Start und
Zielpunkt sowie die Gesamtentfernung angezeigt. Einfach genug?

E ) o W P
21 1% Datei »»

l an 2] 28 Fouten ‘\Wegepunkte

[P | seillimas

21 i { -‘f""’*-, :. | B lzo 48 10m 16M 21 o J1 M Im
oo, R Mk Siesans — (]r Lang[01330.147 €
'il._wgll- F Kor Y i w‘\\_, Geschwing 200 %

L) - Y IMTEMax [ 1050 2

MName

O e
/

\ Wiegepunkiname unc ///g/ Update
VA Update - Schalter Losche Auswahl

Offne Route

%fpeichere Route
%;\\ Losche Route

24

22 ]
200

28
32 P8k ..

(43 {20 A

&

' Jakavija |

25/ o 4 25

' am B

rijal W b7 A0
Plie, Grbo/ibsy ¢

]35 wWeitere Schnell Schater

- S HRouten-Liste
.y 16 § \ Schhiee Editor

z 1! \\ weitere Wegepunkte

. 139 " “Wegepunkt

. H‘Vox 11} Sedov [ =

'N“é Zeige Wegepunkt
\ = 5‘*—-—_| Routen Statistik

Start: 1zola

End=Umag

Pli¢ Zahestraf 473 7 \ Digt: 11.92

Machen wir ibungshalber noch eine Route.

Segeltérn von Umag, mit Badestopp in der Bucht von Dlja, nach Novigrad.

Bearbeiten > Routen Editor > Losche Route damit wir eine neue Route schaffen kénnen.

Sie planen nun, vergeben Routennamen und priifen am Ende visuell diesen ca. 9 nm langen
Torn.

Ein Tipp dazu — wenn sie in eine Bucht hineinfahren und wieder im spitzen Winkel
herauskommen berechnet SeaClear die kiirzere Strecke. Wir kdnnen ihn aber tberlisten
indem wir die Punkte mit Linksklicken und Halten “nachverschieben” und dann die Namen
andern. Ist die Route komplett? Loschen sie die Route — sie wird nur vom Bildschirm entfernt.
Komplett [6schen kdnnen sie Routen oder Wegepunktdateien mit SeaClear nicht mehr.
Nutzen sie dazu das Arbeitsplatz- oder Explorerwerkzeug.

Wir sind in der Normalansicht und laden nun erneut mit Offne Route aus dem Fenster die
Route Umag — Novigrad.SRW und drehen sie mit Routenumkehr um. Wirden wir tatsachlich
in Novigrad sein wirde dies SeaClear Uiber die GPS Position bemerken und die Route
automatisch umkehren. Da wir ein flottes Boot haben und nur tbers Wochenende zum
Segeln waren, wollen wir in einem Schlag nach I1zola. Klicken also erneut Route 6ffnen und
verneinen die Anfrage Alte Route I6schen? Wir wéhlen die Route Izola — Umag.SRW und
bestéatigen dies.

Praxishandhabung Kartenplotter SeaClear - 16 - © Skipper UDO skipper-udo.de



Auf der Karte wird nun die neue Gesamtroute aufgezeigt und im Routen Statistik-Fenster
angezeigt. Novigrad — Izola, Distanz 21 nm. Wirden wir nun wirklich segeln, Uberspringen wir
die Badebucht einfach. SeaClear bemerkt das und wiirde ab Dalja West weiterkalkulieren.
Die neuen Routen kopieren wir auf ein Speichermedium und kdnnen sie an Bord mit dem
Explorer in das Verzeichnis c:\navigate\seaclear2\routen verschieben.

% e i Marko Wollen sie am Schreibtisch schon einmal segeln —
- ;::f:rzugte e # zumindest Virtuell? Kein Problem! Klicken sie dazu nach
enia Izola. Machen sie dort, genau an dem Punkt an dem sie
ot ihr Schiff haben méchten, einen Rechtsklick > Bearbeiten
Zaom v| wpRZON > Setze DR Pos. Die DR Funktion Gbernimmt im Ausfall
Eealbelizn B|  Logbuch Eintrag des GPS die Steuerung des Schiffes, basierend auf den
" MARKIERE MOB cceliPeE I3 letzten Daten. Da wir aber keine letzten Daten haben,
neuer Bidschimautbas. S€1ZEN Wir das Schiff manuell an eine gewilinschte
Einstellungen Position. Falls das T
o Mad Izo| _ Sehlsfe Schiffs_ymbgl nicht zu
sehen ist wahlen sie
einen anderen Zoomwert. Nun ist unser Schiff zu sehen und -SF

wir tragen im roten GPS Feld Kurs und Geschwindigkeit ein.
Ist der Schalter ,Verlaufsspur EIN“ aktiv? Mit jeder
Kursénderung (Uber 5°) wird der Verlauf dargestellt und wir
kdnnen sehen ob wir an der geplanten Route entlang fahren oder korrigieren sollten — wie im
wirklichen Segeln. Gut auf dem unteren Bild zu sehen ist der kleine ,Vorhalte-Kreis".
Eingestellt auf 300 Sekunden =5 Minuten. Den WP # Ronek werden wir also in etwas mehr
als 5 Minuten erreichen und dann den Kurs wechseln. Wohin? Aktivieren sie ihre Route und
wir finden die dazu nétigen Daten rechts. Was nun noch fehlt (und schlecht simuliert werden

geschatze Geschwindighkeit I{Kt]l|
5

AlE (TR T
% 261.6°
5.0kt
Geplanter Kurs zum Wegepunkk
TThL 185

kann) — sind Windabdrift, Strom und Seekrankheit.
Bei dieser Simulation wird ebenfalls eine Trackdatei geschrieben — diese kann z.B. in Google
Earth dargestellt werden (siehe weiter unten).

Mit jedem erneuten Start 6ffnet SeaClear die Software an der zuletzt bekannten Position mit
der dafir besten Karte — also nicht mehr am Aquator.

Damit haben Sie auch schon die wichtigsten Schritte vom Erhalt der Software bis zum
Digitalen Segeln durchgefuhrt.

Ein bisschen Praxis im Herumklicken auf einem PC und Sie werden Zirkel, Bleistift und
Messdreiecke fir immer im Kartenschapp liegen lassen kdnnen.

Und Strom und Windberechnung? Nun der PC féhrt Lifezeit und plottet dies mit.

Wir weisen unseren manuellen Rudergdnger an, anzuluven oder abzufallen — bis Track und
Routenlinie sich annahern oder zumindest nahe beieinander parallel verlaufen.

Bis auf raueste See aber schlagt der Autopilot eh jeden menschlichen Ruderganger und der
Automat erhdlt ja ab sofort “seinen” Kurs von SeaClear.
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Sollten sie Spal3 an dieser Digitalen Option der Navigation gefunden haben bietet die CD
noch einige Erweiterungen fir diesen Kartenplotter an.

AIS Signale

Die Berufsschifffahrt ist ab einer bestimmten GroRe verpflichtet ein Automatisches

Identifikations System zu betreiben. Dieses Signal wird per VHF (UKW) ausgestrahlt und hat
eine quasi-optische Ausdehnung von 25 Meilen und mehr. Da hier ein GPS Signal
eingespeist wird, werden viele wichtige Daten sehr exakt tbermittel. Wenn auf inrem Schiff
ein AIS- Sende-/Empféanger oder Empfénger angeschlossen ist, kann SeaClear diese NMEA
Daten als Ziele darstellen. Dies ersetzt ein Radar nicht — aber mit AIS kann man abhangig
von der Reflektion um die Ecke in einen Fjord / Bucht sehen — leider sind noch nicht alle
Schiffe mit diesem System ausgertistet.

AIS Sender werden mit dem HDT Datensatz (soweit vorliegend) dargestellt, sonst mit COG
(Kurs Uber Grund). Sollte das ROT Signal empfangen werden, wird ein Wendekreis
angezeigt. Der Geschwindigkeitsradius hat denselben Vorhalt wie der von ihnen
voreingestellte Speedmarker (=Erreichbarer Punkt in * Sekunden). Die Fahrtrichtung des AIS
Zieles wird bei entsprechendem Kartenmalf3stab angezeigt

Im AIS Rollmeni werden alle AlS Sender dargestellt und bei jedem 6ffnen des

Rollmenus aktualisiert.

AIS Sender. Bei einem Anklicken des Zieles wird die geplante Fahrrichtung falls moglich
angezeigt, ansonst zeigt es den COG mit dem Wenderadius. Um weitere AlS Informationen
des Zieles zu erhalten klicken sie Rechts auf das Ziel und wéhlen Bearbeiten->AIS Info.
Darauf 6ffnet sich ein Popup Fenster das die relevanten Daten fur dieses Schiff anzeigt — nun
wird es viel leichter die Briicke dieses Schiffes mit VH
Mandver s
abzusprechen.  |-=N.----
verkehrsdichten &
Zonen reagieren
Schiffe der
Grolschifffahrt
namlich nicht

19.04. 2007 16:59:12‘:J

Nl Hame: EURCOPE
mehr auf den : i /|callla: FKIB
Anruf ,Big ship, Elgenes Schif PORTDEC[EEE""  Boopn oo ( big

COG: 262, 3°

HDT: 265°

ROT: 7T min

Lat : 43°23 294'H

PORTDE
SERVICE

ship — thisis...."

Das

ausgewahlte
Signal wird mit
einem
gestrichelten

Long: 004°50.740'E
Length: 29m

Width: 10m

Draft: 3.5m

MMSI #: 227403000 AlS
Status: Engaged in Fishing
ENG: 0.444NH

EBRG: 71°

CPa: 0.090FH

TCEA: 00:03:04

Rechteck PALISSADE 1§
dargestellt! - TS D FOOS TATT =
CPA Kollisionswarnung auf der Karte.
» Wenn sich die CPA (Closest Point of Approach = Nahester Punkt
! der Anndherung) und TCPA (Time to CPA = Zeit zum CPA Ziel)
R ! der Uberwachungszonen nahern wird eine Warnung in Form von
“smhqgﬁ'q 2 sich uberschneidenden Ringen dargestellt.

Der eine Kreis ist das eigene Schiff mit Berechnung COG (Kurs
Uber Grund) und der voreingestellten CPA Max (Zeit oder
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Entfernung). Der zweite Kreis ist das gegnerische AIS Signal (Schiff) mit COG
Darstellungsrichtung, Schiffsname und (falls mdglich) der Schiffslangenradius. Die CPA
Warnung wird solange angezeigt wie TCPA (Kollisionszeitpunkt) zwischen 0 und TCPA Max
liegen und CPA kleiner als CPA Max zuzuglich der Schiffslange ist. Die CPA Daten werden
dabei fortlaufend mit allen AIS Sendern, die dargestellt werden, neu berechnet.

Sobald eine berechnete Warnsituation nicht mehr vorliegt, wird sie auch nicht mehr
dargestellt. Um Warnsituationen nicht auf dem Bildschirm angezeigt zu bekommen muss der
TCPA Max Wert auf 0 gestellt werden.

Beachte: Bei SeaClear muss evtl. die Baud-Geschwindigkeit bei AIS Empfang unter

Bearbeiten > Com veréndert werden (geschickt wird der Datensatz
$PNMLS,ss, tt,r*cc<CR><LF> mit 38.400 Baud).

Track bei Google Earth darstellen

Die Speicherdatei fur Tracks (Verlaufsspur) liegt im Unterordner ..\SeaClear\traces mit einer
Endung die fir die Darstellung in Google Earth nicht sehr hilfreich

ist. Die Datei kann aber als *.txt Datei exportiert werden. Offnen Nachtabdunkelung
sie dazu SeaClear und schalten die automatische Track- 1 < 3 4
Aufzeichnung Verlaufsspur AUS. Solange die AUTOMATIE AUS
Trackaufzeichnung aktiviert ist, zeichnet SeaClear permanent die Verlaufsspur,EIN
Schiffsbewegung auf und vergibt ab 0:00 Uhr (taglich neu [ﬁ

beginnend) einen neuen Dateinamen. Wir kdnnen also einen Tag oder mehrere Tage laden
und dann exportieren. Beim Export wird eine *.txt Datei erstellt.

Datei Bearbeiten >3
| karts » B
...__‘ Rouke | S

) Wegepunkt ¥ = Datei Bearbeiten
OFfne alken Track D? Track >
Importiere GPS 2

N | Karte (|
- 1
Export Text = ____-_-'-_ Route '
3 .-'- ‘ Wegepunkk

Drucke ] - =
r Schliefie -._."f v Offne alten Track Track _
| L—I Irnportiere GRS [
Zeige Wegepunkt /-/ ]
E L F E E: H Fiouten Export Text I} Karten Info .
_E ) Offne Route -‘L Drucke :
=r. Rantannmk ahr - Schiiefe .
Wenn die folgende Musterzeile kopiert wird und als Zeile 1 (siehe Muster) eingefugt wird,
kann GPS Babel (ein Ubersetzer fir GPS Protokolle — s.weiter unten) dieses Protokoll in

andere Formate umschreiben — so auch in ein Format das in Google Earth dargestellt wird.
Musterzeile:

k.arken Info

Date,Time,Latitude,lLongitude,speed,sat

Eine *.txt Datei wird mit einem _|coruna.TXT - Editor
Linkdoppelklick automatisch Datei  Bearbeiten Format  Ansicht 7

mit dem Win-Editor getffnet. - - 5
Mit dem Cursor vor dem ersten ||Date, Time,Latitude,Longitude, speed, sat

Eintrag wird mit einem 05.06.2008,23:13:09, 44.01320,-7.46002, 5.8,0.4
Zeilumbruch eine neue leere 05.06.2008,23:13:18, 44.01310,-7.46927, 5.9,0.4
Zeile erstellt. Kopiert man nun 05.06.2008,23:13:38, 44.01283,-7.40997, 6.1,0.4
die Musterzeile hier hinein und 05.06.2008,23:40: 24, 43,99253,-7, 52337, 5.8,0.4
speichert die Datei ist sie oottt T TT T TTTm o T '
vorbereitet fir eine Umwandlung in GPS Babel.

BEACHTE: Speziell fir SeaClear gelten folgende Einstellungen:
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Die Software und eine Erklarung was wie eingestellt werden sollte, ist auf der CD unter
..\Nautik\Seekarten fur Google Earth . Track in Google darstellen.pdf beschrieben.

Speziell fir SeaClear aber gilt:

»»» Eingabe

Formnat |L|niversa| cav with field structure in first line 1_‘:ﬂ Dptionen L) | ﬂ | J

[Gerat] I

D atei "CATemph THT! ~
atei | EmphCorna. z.j'ﬂ

<< fuzgabe

Format |Gnngle Earth [Feyhalz] Markup Language 3._l| Optiaren % |e:-:tlude=1,max_positij4\ J

[Gerat] I
D atei |C:'\Temp'\Cnruna.ka 1 L=

was? B wegpuriee(B N 5...'EEilter | & wndlos |

ten % [ Tracks

-

4 3
GPZEahel, Wersion 1.3.5 |hitp:ifvanw.gpshabel.org

1. Universal... Input Datenformat einstellen
2. Startdatei (mit Musterzeile) auswahlen, dabei den Rollbalken Dateityp auf ,Alle
Dateien” einstellen
3. Google Earth... Ausgabeformat
Wé.hlen ™ Standard Symbol ’7
4. mlt elnem L|nkSkI|Ck |n daS BLICh ¥ Zeichne eine Verbindungslinie wom Trackpunkt zum Erdboden

™ Absolute Hihenangaben (nicht bodenverbunden)
Icon @ f0|gende >SS I¥ Zeige Beschriftung bei Track- und Routenpunkten (Yorgabe: 1)
EinSte”un en auswahlen/éndern ™ Linientarbe (hex Angabe in Form AABBGGRR)
g ™ Linienhohe in Pixel :I
. . ¥ Expontiere Linendaten (linestrings) fiir Tracks und Routen (Vorgahe: JA)
Waéhlen sie ,Routen“umrechnun
aus " g ™ Behalte hichstens diese Anzehl an Positionspunkten (0 = kein Lirnit) 100 :I

¥ Exportiere Markiemungen flir Tracks und Routan

5. Im Filter wird ebenfalls die max.
Anzahl auf 100 herabgesetzt

¥ Erweiterte Daten in Trackpoints mit einbeziehen Vorgabe = 1)
™ Erzeuge spezielle lcons (Richtungspteile)

¥ Einheitinnerhalb von Kommentaren ('s'tatute oder 'm'etrisch) ]

Achtung: die meisten Optionen sind wermutlich fiir die Datenausgabe gedacht,
Wir verfugen 2.2, uber kein Merkmal uber die Sibeitsweise der Optionen.

? Hire o 0 X Abbrechen ‘

Bouten & Tracks

W “ereinfachen ©maximal (100 jl Purikte
[ Umdrehen

# und loz
Tracks mit Linksklick 4"\“L wird die

neue *.klm Datei erstellt.
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|E| Bl e

Sobald diese Datei aus einem Explorer doppelt geklickt wird, startet automatisch (Google
Earth bereits installiert) die Anwendung und stellt
die Datei als Tracklinie dar. Sie sollte in ihren + 17 & Uau Seskare

Ordner mit Linksklick und ziehen in ,Eigene Orte* R e
verschoben werden. Mit einem Rechtsklick in die £1E] & Segein Grischenland

Datei kann mit Umbenennen die Datei in einen AR ORI R
. @ Zakyrthos
passenden Dateinamen (z.B. Datum und Strecke) o —

geandert werden. Hinzuftigen

= F arried Ravern .
Kopieren

Li=chen

Inhatt 1&=chen

Ausschneiden

Ansicht: Wiederherstellen

Fmicbere |

G7ToWin fur den Datenaustausch mit einem GPS

Falls sie Daten an ein Einbau- oder Hand GPS senden oder empfangen mdchten
(Wegepunkte oder Tracks) installieren sie die Go7ToWin.exe in das Verzeichnis in dem auch
die seaclear.exe liegt. Dabei die ..\SeaClear\g7towin.Zip-Datei der NavCD zuerst in ein
Temp-Verzeichnis entpacken und dann mit einem Doppelklick die Installation beginnen.
Beachte: Einige GPS Gerate bendtigen eine NMEA-Protokollumstellung um mit G7ToWin
Software Daten austauschen zu kénnen. Die G7ToWin Version A.00.140 wurde getestet,
neuere Versionen sollten ebenfalls funktionieren.

Weitere Hinweise sind in der Deutschsprachigen Betriebsanleitung aufgefiihrt

Trackpunktauswertung

Mit einem weiteren Zusatzprogramm kdnnen sie ihren letzten Térn digital auswerten.
Entpacken sie dazu die ...\SeaClear\seatrackedit.zip in ein Temp Verzeichnis und starten von
dort die Installation durch einen Doppelklick auf die setup.exe.

Uber das Startmenii oder einem selbst erstellten Desktop-lcon kann die Software auch ohne
den Betrieb von SeaClear gestartet werden. In dem nun gedffneten Fenster wahlen sie zuerst
eine gewtlnschte Verlaufsspur (Track-Datei) aus dem Unterverzeichnis ...\SeaClear\traces
aus.
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% SeaTrackEdit V1.1.102

Inpuitfile:

Turn angle which
marks a rew Tack I3U

1560 0r O

& Output all waypoints

Olutputfile:
" Dutput rack waypoints only

Comments | Simulation Settings |

| Tipt#| Date and Time [UTC| Latiude | Longitude | COG [ 506 |uiCOG] wiist | wiTime | wiS0G | CumDist | CumTime | Cumé50G

Die oder mehrere Tracks kénnen geladen und mit einem Klick auf den Plot Route Schalter
dargestellt werden.

3% SeaTrackEdit V1.1.102 M=%

Inputfile: C:\MavigatehSeaClearitracesh20051124. TRC

Delete Open File | Logs to Clipboard |
Turn angle which
marks a new Tack i3U ' List Tack Data
15E0ar 0 e
Dukputfile: Save I f* Output all waypaints

£~ Output track wappoints anly

I Simulation Settingsl

Trptt| Date and Time (UTC|Latitude  [Longitude  |COG | SOG | wiCOG| uilist | wiTime [wiSOG | CumDist | CurTime | CurnéwS0G
0 18991230 00:00:00) 45N 32204 13E 29356 0 00
45N 32277 13E293%8 0 00

0:00:00

10,072 000 007

Jetzt wird ihre Route grafisch dargestellt und mit den jeweiligen Einstellungen kénnen die
Kurse als Richtung und Geschwindigkeit farblich dargestellt werden.

Eog i e T L T, a1 ]

Trimmauswertung

Mit dem Zusatzprogramm SeaTrace kdnnen sie viele NMEA Signale darstellen und (sobald
angeschlossen) ihr Schiff optimal trimmen und digital

auswerten. Entpacken sie dazu die ...\SeaClear\seatrace.zip in Route Wit havige ey

. . - - . WayPaint Dir=Ci\Navigs
ein Temp Verzeichnis und starten von dort die Installation durch Lo ;

. ) . _ Track Dir=C:%\Mawvigateh!
einen Doppelklick auf die setup.exe. Legen sie den Pfad so ir=C\Navigatehs
dass es in das Hauptmeni von SeaClear installiert wird. :DDE=1 b
Bevor sie nun die Software Uber Start > oder ein Icon starten, =1
mussen sie aber die seaclear.ini umschreiben. Doppelklicken AIS Labels=2
sie also im Verzeichnis ...\Navigate\SeaClear die AIS Panel=1
SEACLEAR_2.INI an (oder &éffnen diese mit einem Editor) und AIS Marker Color=3
tragen wie in unten stehen Beispiel DDE=1 in das Setup ein. ﬂg TSQA‘;B'T' C?'?fﬁg B
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% SeaClear [Izola, Hafen - 1:7009 @ 100%] - [RR=1]

— = Datei Beabeien >>
I8 100% on battery ~.3 /¥ wind Graph ) o—
| tnchanged 28.11.2005 1528 42 (€] Help =] o] v | Start Tme 2005112815615 _« | » | -
] <>
1005 on battery ST Eelar =l
j
Lat 4553796 =1
" Lon 1365596 0
s0G 0.0 \wegepunkt
oG 1} i -
— Mag o f | Zeige Wegepunkt
Mar 2.09 E ‘ Routen
DET 0.0 = 2 Offne Route
TWa 0c: [1} Routenumkehr
AWH o 340 o Aktiviere Route
TWD 0 cC: [1} 15:30:00 15.45.00 16:00:00 161500 16:30:00 16:45:00 | Routen Statistik
WS 0.0 C: 0.0 _Color | [start) _Color | /| Stert: Pisa
AWS 0.0 UL B e FTH o N S TN TR - - - E::E#E;;:‘;‘;
pat (=t0 5 SeaTrace Tables B@ //\‘ﬁ A5 Info  Find
&; HDG 1} Damping 1 ‘— =
- Factor
fl:s e L:l‘::l " True Wind Angle Correction Table  [Double Click a cel to change] 1
LongibSLabot 7 T +
i . X X X I T ®
Il Gie el Feaching 90| 00 00 00 00 00 00 - —
XTE Labell Dowrwind 165 005 5% 00 00 o0 oo
. BIW Labell L
DTW Labell True Wind Speed Correction Table  [Double Click a cell to change)
__ WP CSPD Labell P £ TWS |__ 50| 100] 150| z2o0.0| 260 3o00] “1]
“Name WP Labell okt 00 00 X X X [0 e LTS
o angle: 165 165 165 165 165 15| b ese Mittig
é HNachtabdunkehing
| 2 z s Polar Table [Double Click a cell to change] - J = RN
N e Dummy 1 |_ 40 s0] 80| 100 120 140 160) 200 , < AUTOMATIK AUS
. Dummy2 TWh_min 380 380 300 380 380 31O 380 30| g Verlaufsspur EIN
- o 3 Twi, F TSP 3.0 30 4.0 40 50 50 B0 E.0] 4 |
7, 40| 00 70 200 70 20 &0 00 70 = 7
] 2y 45| 30 30 400 40 50 50 60O 60 X S “153.33;[2'3';.2
e g e T 190" 0.19 10
mﬂiﬂ TS eEZTO Orem | e rianview [ Biseackarn | 382 cearace  ~| ‘ SR LEBED 1628

Wird nun die Software SeaTrace gestartet [adt sie auch automatisch SeaClear und stellt die
nétigen Fenster dar. Die Werte in den Zellen kénnen verandert werden.
Fur weitere Infos siehe im dortigen Hilfsmenu.

Ein kleiner Tipp zum Schluss: sobald sie mit der Menloption vertraut sind, sollten sie sich
das Manual nochmals durchlesen. Viele weiter zusatzliche Einstellungen und
Arbeitserleichterungen (w.z.B. Shortcuts, sind dort genau beschrieben).

Beispiel:

o0 SeaClear errechnet und zeigt im Nav-Fenster oben, sténdig die aktuelle Missweisung
an.

0 Sollten die GPS Daten vortibergehend fehlen, plottet SeaClear den Kurs und
Geschwindigkeit weiter (basierend auf die letzten Daten)

o Egalin welcher Karte sie gerade herumstébern, mit einem Doppel-Klick im
Koordinaten Fenster sind sie wieder bei ihrem Schiff

0 Route zu kompliziert? Rechtsklick auf der Karte zum gewtinschten Zielpunkt >
Wegepunkt > Setze Markierung und schon werden Peilung und Entfernung
permanent unten rechts angezeigt (mit einem Rechtsklick auf den WP kann er wieder
deaktiviert werden)

0 Rechtsklick am gewlinschten Startpunkt in einer Karte > setze DR Position und schon
kann man ohne GPS eine Fahrt simulieren. Hierzu im Roten Koordinatenfeld nur den
gewtnschten Kurs und Geschwindigkeit eingeben.

Bis zum néchsten Stromausfall wiinsche ich einen wundervollen Wochenend-Térn (oder
wollen sie gleich um die Erde?) und viel Spal3 mit Elektronischer Navigation! Skipper UDO
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